
 
 

INFORMATION TECHNOLOGY 

UNIT – II : MS – WORD 

 

1. What is Word Processing or MS Word?  Explain its Features. 

Ms-Word is a word processing program that is used to edit, save and print the various letters, 

documents, reports, memos and statements. The word processors examples are Ms-word, WordPad 

and notepad.  

Features of Ms-word are: 

1. Typing:  Typing is so easy because we need not click enter button, after the end of a line. The 

cursor will go to next line of the document automatically.  This facility is called word wrapping. 

2. Saving: The document typed can be stored for future use.  The process of storing is called saving. 

3. Adding, Removing and Copying Text: Documents can be modified easily by adding a new 

word at the required place. If there is no need of a word , remove the word. For the duplicate copy, 

we can copy the text and paste it. 

4. Spell checker of Words: -   The spelling is checked automatically.  We can find alternative 

words to our typed words and grammatical errors can also be corrected in word processor. 

5. Change the Style and Shape of Characters and Paragraphs: The text can be applied different 

font styles and also we can change the alignments of the text. 

6. Bullets and Numbering: Bullets are special symbols which can be put for different points or 

paras in a document whereas numbers like 1, 2, and 3………etc. 

7. Headers and Footers:  A header is the text appearing above the document and Footer is the text 

appearing below the document. 

8. Creation of Tables: We can insert the table or draw table in ms word. The rows and columns 

can be selected in the insert table option. 

9. Inserting Pictures Objects: we can insert the picture in the document to make it more attractive. 

10. Preview Facility: Before getting a print or our document, we can get a preview of document.  If 

mistakes are there, we can change the document. 

11. Mail Merge Facility: If we want to send the same information to different persons, there is a 

facility in Word Processor known as Mail Merge. 

12. Paper Size and Orientation: We can select the size of paper and orientation in M.S Word.  We 

can select a paper with small size for visiting card also.  

13.  Macros:  With the help of macros, we can avoid repetitive works this saves our time and 

efforts. 

2) What are the  Advantages and Applications of MS-Word 

Advantages :  

1) Quality: Word produces error free documents. The spell and grammar check in word processing 

makes the document to be error free.  



 
 

2) Storage of text: We can take any number of copies with word processor. If we need this same 

document with slight changes we need not type the same letter again just by making some slight 

changes we can obtain a modified copy easily.  

3) Time saving : We can get any number of copies of documents in future without re typing  

4) Securities: We can protect the documents of word by giving pass word.  

5) Dynamic exchange of data: We can have dynamic exchange of objects and pictures from other 

documents into word processing document. The documents can be linked each other. 

Applications or Uses: 

 

Following are the top  professional and personal uses of Microsoft Word 

1. Business and workplace use of Microsoft Word: – 

You can create all types of official documents in Microsoft Word. You can use the template 

function in Microsoft to download letterhead samples, bills, and cash memos, joining letters, 

receipts, letterheads, and all various types of accounts management related work. 

2. MS word uses in Education: – 

Microsoft word is the best teaching tool for teachers. You can create a lecture script by using text, 

word art, shapes, colors, and images. That will explore creativity in students. They will watch a 

slide or printed document more interestingly. 

3. Home-based users of Microsoft Word: – 

You can create a birthday card, invitation card in Microsoft Word by using pre-defined templates or 

using insert menu and format menus functions. You can also type a letter to the municipal party on 

MS-Word. 

4. Microsoft Word helps you to get a job: – 

Microsoft Office’s basic knowledge can play a big role to get you a job. As you learned above 

business and commercial uses of Microsoft Word. It means the basic and advanced knowledge of 

MS Word can help you to get a job. And it’s’ great skill that you can highlight in your resume. 

5. Help to create resumes, notes, and assignments: – 

You can create notes and assignments on MS-word. It’s easy to write and format text in Microsoft 

word by using various text formatting options such as paragraphs, fonts, styles, etc. You can insert a 

cover page, you can insert watermark and tables in your assignment according to your choice. 



 
 

6. You can create books, articles, and newsletters: – 

Microsoft word is used by millions of people around the world for document writing since its 

launch. And writing a book in Microsoft Word is really easy. There are lots of features and 

functionality that can help you to create and print a book. 

 

3. What are Ms-Word window components?  

Some of the components of ms word are: 

Title bar: The title bar is a bar located at the top of a window that displays the name of the window. 

Menu Bar: This bar displays the headings for each drop-down menu. Commands such as home, 

insert, page layout, references, mailings, review, view, design and layout appears in this menu. 

Standard Toolbar: This toolbar contains short cuts to some of the most frequently used commands 

from the menu bar. 

Formatting Toolbar: This toolbar contains short cuts for formatting options such changing font 

styles, colours, alignment centre etc. 

Status Bar: This bar displays information about the active document like number of pages , words 

etc. 

Rulers: Rulers in Word help you to place text, images, tables, and other elements in your 

documents by using margins, indents and tabs. 

View buttons: 

This changes the layout view of the document to Normal view, Web Layout view, Reading Layout 

view, Print Layout view, Outline view, and Full Screen view. 

Quick access tool bar: It provides the shortcuts and is used to save, undo or redo the applications 

easily. 

Scroll bar: A vertical or horizontal bar located on the right or bottom of a window that allows you 

to move the window area up, down, left, or right. 

http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Menu%20Bar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Standard%20and%20Formatting%20Toolbar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Standard%20and%20Formatting%20Toolbar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Status%20Bar


 
 

 
 

4. How to Create, Saving, Closing, Opening, Printing and Exit from a Word 

Document? 

In MS Word we can perform the following basic operations in every word document. 

Creating a New Document: 

A new document can be created by choosing the following steps: 

1. Click Office button and select the new option.  

2. A window open and select the blank document and click create. 

3. A new word document opens.Shout cut key is CTRL+N 

Saving Document: 

 

1. Click on the Save Option in the Office button 

2.  Save the file with its file name, choose saving location, and file format.  

Shortcut key is CTRL + S 

Save As:-The Save As command lets you save the document with a new name and continue to work 

on it. 

Close Document: 

To close all opened files after working click Close Option in the Office button. 

In Short cuts keys are CTRL + W   or ALT +F4     

Opening a Document: 

You can open documents from different locations choosing the Open dialog box in Word.  

1. Choose open from the Office button. Specify the correct file path were your file is stored. 

2. Choose the file by clicking it once and click the open button in the dialog box. 

    Short cut key    CTRL + O     



 
 

Printing Documents: 

The print Command in word is used to print the document that is the hard copy of the document. 

Specify options in the print dialog box such as  

 Name of the printer 

 Number of pages 

 All pages 

 Current page  

 Number of copies. 

    Short cut key    CTRL + P     

Print Preview: 

A view that shows how a document will look when you print it. You can view multiple pages at a 

time, by zooming or reducing the size of the page on the screen. It displays all the details such as 

paper size, margins, orientation etc. If there is any need to change then change the required one. To 

display a document in print preview, click Print Preview on the Office button. 

5. How to Copy and Paste Text in MS Word 

Word offers different methods to copy and paste text. Some of the popular methods are given 

below; 

Method 1; 

o Select the text you want to copy 

o Select the Home tab and click the Copy command 

o Place the cursor where you want to paste the text 

o Click the Paste command in Home tab 

Method 2; 

o Select the text 

o Place the cursor over the text and right click the mouse 

o A menu will appear; with a left click select the "Copy" option 

o Now, move the cursor to a desired location and right click the mouse 

o A menu will appear; with a left click select the 'Paste" option. 

 

6. Explain about formatting text in MS – Word. 

Formatting Text:  Characters are individual letters, numbers, symbols, punctuation marks, and 

spaces. You can apply one or more formats to a single character or multiple characters. The character 

formats you can apply are font and font size; font style such as italic and bold; and bold; and font 

effects such as underline, color, and change case. The font group is on the Home tab of the Ribbon, 

shown in figure, and contains buttons for formatting text. 



 
 

 

Formatting Paragraphs: The alignment, spacing, and indentation of text in a document depend on 

the formatting you apply to paragraphs. Word refers to any amount of text or other items followed 

by a paragraph mark as a Paragraph. 

To apply paragraph formatting, position your insertion point anywhere in a paragraph. Word will 

apply the paragraph formats you select to the entire paragraph. You cannot apply paragraph 

formatting to only a selection of the paragraph. 

Line Spacing: 

 

 Line Spacing sets the amount of space between lines within a paragraph.  

 The spacing for each line is set to accommodate the largest font on that line. 

 If the lines include smaller fonts, there will appear to be extra space between lines where the 

smaller fonts are located.  

 At 1.5, the line spacing is set to one – and – a – half times the single – space amount.  

 At 2.0, the line spacing is set to two times the single – space amount (double space). 

7. How to create a bulleted and numbered list in Microsoft Word, 

The Microsoft Word keyboard shortcut key to create a bullet is Ctrl+Shift+L. 

1. Position the cursor where you want to insert the bullet list. 

2. On the Home tab in the Ribbon, click the bullet list button, as shown at the top of the page. 

3. If successful, a bullet should appear. Type any text and press Enter to start the next bullet. 

To end the bullet list, press Enter twice. 

To create a numbered list in Microsoft Word, follow the steps below. 

1. Position the cursor where you want to insert the number list. 

2. On the Home tab in the Ribbon, click the number list button, as shown at the top of the page. 

https://www.computerhope.com/jargon/k/keyboard-shortcut.htm
https://www.computerhope.com/jargon/c/cursor.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/b/bullet.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/r/ribbon.htm


 
 

3. If successful, a number one should appear. Type any text and press Enter to start the next 

number in the numbered list. To end the numbered list, press Enter twice. 

8. How to Find and replace the text or word in a document? 

1. Click on the Find and Replace dialog box. 

2. In the Find What box, type the text you want to find. 

3. In the Replace With box, type the text you want to use to replace the original text. 

4. Click the Find Next button. 

5. Click the Replace button. 

6. Keep replacing. 

7. Click the Close button 

 

9. How to insert page numbers? 

Insert Page Numbers: - 

 We can insert page numbers at the required place on the document pages. 

1. On the Insert menu, click Page Numbers. 

2. In the Position box, specify whether to print page numbers in the header at the top of the 

page or in the footer at the bottom of the page. 

3. Select any other options on the position box you want. And click on the OK button. 

 

 

 

 

 

 

https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/n/numberin.htm
https://www.computerhope.com/jargon/e/enterkey.htm


 
 

10. How to insert Symbols or Special Characters, word art, equations, shapes? 

( OR ) How to insert objects? 

 

Insert Symbols or Special Characters: - 

You can insert special characters and symbols by using the Symbol command on the Insert 

menu. You can also insert a character or symbol by typing the character code on the numeric 

keypad. To quickly insert a symbol that you use always, assign the symbol to a shortcut key. 

1. Click where you want to insert the symbol. 

2. On the Insert menu, click Symbol, and then click the Symbols tab. 

3. Double-click the symbol or character you want to insert or click on the Insert button. 

Insert word Art: 

1. Click on the insert tab and select the word art. 

2. The different types of word arts appear. Choose any one. Then a window appears. 

3. Type the text that you want in word art and choose the bold, italic. 

4. Click ok. 

5. If needed change the shape. 

Insert Equations: 

1. Select the insert tab and click on the equations. 

2. Choose the type of equation needed and click on it. The equation appears. 

3. Chang the required fields or numbers. 

Inserting shapes: 

1. To insert shape, click on the insert tab. 

2. Select the required shape such as line, banner, stars etc. from shapes option. 

3. After selection, a plus symbol appears on the document. 

4. Click and drag the symbol. 

5. If you want any changes such as fill color, styles, 3d effects apply them.  

11. Write about Header and Footer in MS-Word? 

A header or footer is text or graphics such as a page number, the date, or a company 

logo that is usually printed at the top or bottom of each page in a document. A Header is printed in 

the top margin and Footer is printed in the bottom margin. You can use the same header and footer 

throughout a document or change the header and footer for each page.  

Insert a Header: 

1. On the Insert menu, click header.  

2. Select the type of header such as normal or border header. 

3. If you want to edit header click on edit header. 

4. If you want to remove header click on remove header. 

Insert Footer: 

1. On the Insert menu, click footer.  

2. Select the type of footer such as normal or border footer. 

3. If you want to edit footer click on edit footer. 



 
 

4. If you want to remove footer click on remove footer. 

To remove a header or footer from your document: 

 Click the Insert tab.  

 Click either the Header or Footer button from the Header & Footer group.  

 Click Edit Header or Edit Footer. 

12. How to format a page or Page Formatting 

This section will show you how to change your page margins and page size, how to insert headers 

and footers, and how to add page numbers. 

Page Margins 

You can change the page margins of a document by using either the rulers on the sides of the page 

or the Page Setup dialog box. 

To use the ruler method to change the page margins of a document: 

1. Click inside the document to select it. A ruler will now run vertically across the top of the 

document, and horizontally down the left of the document. 

2. Move the mouse over the area where the white ruler changes to blue. The cursor will change 

to a double-ended arrow. 

3. Click the mouse and drag the margin to the desired location. 

To manually set the page margins using the Page Setup dialog box: 

 Click the Page Layout tab.  

 Click the arrow in the bottom-right of the Page Setup group. The Page Layout dialog box 

will open.  

 You can enter margin values in the Top, Bottom, Left, and Right boxes. The Preview pane 

allows you to view these changes.  

 Click OK. 

Page Size and Orientation 

By default, the page size is set to Letter, and most people are accustomed to working with this size. 

However, Word provides many different page sizes that correspond to paper sizes, for example 

Executive, Tabloid, A3, A5. To change the size of your page: 

 Click the Page Layout tab.  

 Click the Size button from the Page Setup group. A menu will open, showing the available 

page sizes.  



 
 

 Choose the size you want from the menu options. 

13. How to insert table or Draw table? 

A table is a collection of rectangular boxes called as cells. A cell is formed by intersection of 

a row and a column. Tables allow large amount of text or numbers to be stored in easy manner. 

Some of the examples of tables are student table, address books, sports table etc. 

 

Steps to insert a table: 

There are two ways to insert a table: 

Method 1: 

1. Click on the insert tab. 

2. In the table group, click the table icon. A drop down list appears. 

3. Drag the table rows and columns from the table grid. For example 3x4 or 5x5 etc. 

Method 2:  

1. Click on the insert tab. 

2. In the table group click the table icon. From the drop down list click on the insert table command. 

3. In the table size, select the number of rows and columns needed. 

4. Click ok. 

Steps to draw a table: 

1. Click on the insert tab. 

2. In the table group, click the table icon. A drop down list appears. 

3. Click on Draw table from the list. Mouse pointer changes to a pencil. 

4. Use the pencil to draw the columns and rows in the table. 

5. Press Esc after drawing table. 

 

14. Explain about Auto correct: 

To use the AutoCorrect feature as you type text in Word 2007, the "Replace text as you type" 

option must be enabled. To enable the option, follow these steps:  

1. Click the Microsoft Office Button, and then click Word Options. 

2. Click Proofing. 

3. Click AutoCorrect Options. 

4. On the AutoCorrect tab, click to select the Replace text as you type check box. 

5. Click OK to close the AutoCorrect Options dialog box. 

6. Click OK to close the Word Options dialog box. 

15. How to check the spelling and grammar in Ms-Word? 

Spelling and grammar is used to make the document free from spelling and grammar errors. 

Green lines are placed under the line if there are grammar mistakes. Red line appears under possible 

spelling mistakes. 



 
 

Check the spelling and grammar when typing: 

1. Place the cursor over the misspelled word and Right-click. 

2. A menu appears with options for correct spelling of that word. Choose the correct spelling. 

3. If the spelling is correct then click on the ignore once. 

Check the spelling and grammar by using review tab: 

Click on the review tab. 

1. Choose the spelling and grammar option in that. A window appears with name spelling and 

grammar. 

2. Click on the words that tare correct. 

3. Select the correct word that is suitable and click change. 

4. Automatically the word is changed into correctly spelt word.  

5. In the same way change the correct words to all the spelling mistakes  

6. If there are no spelling mistakes click ignore once or ignore all. 

7. After completion a dialogue box appears showing message that spelling and grammar is 

complete. 

8. Click ok. 

16. What is Thesaurus? 

A thesaurus is a book, software program, or online service that provides alternative or similar 

words to a word. For example, searching for "hope" may return synonyms like "achievement," 

"faith," "ambition," and "optimism." 

17. What is mail merge? 

Mail merge is used to create multiple documents at once. These documents have same layout, 

formatting, text, and graphics. Only some part of each document is varied. The documents Word 

can create with mail merge are labels, letters, envelopes, and emails. 

Mail Merge Step by Step: 

 

Select Mailings   Mail Merge and click step by step mail merge wizard. 

 

Step 1: Select Document Type 

1. Under Select document type, choose Letters. 

2. Click on Next: Starting document at the bottom. 

Step 2: Starting document 

1. Selecting Use the current document will allow you to start from the current document shown 

on the screen. 



 
 

2. Click Next: Select recipients. 

Step 3: Select Recipients 

1. Select Use an existing list or type a new list. 

2. To find an already existing file, click Browse 

3. Type a new list if list is not there. 

4. Add the field names and type the all the recipients names. 

5. In the Mail Merge Recipients window, select the recipients. 

6. Click on Next: Write your letter. 

 

Step 4: Write Your Letter 

1. Type the letter, then click on More Items and insert fields where required. 

2. Click Insert, and then click Close. 

3. Click Next: Preview your letters. 

Step 5: Preview your letters 

1.  To preview the letters click the Preview your letters heading. 

2. Click on Next: Complete the Merge. 

Step 6: Complete the Merge 

1. Click Edit individual letters... 

2. In the Merge to New Document window, select the records you want to merge. 

3. Click OK. 

Step 7: Save the Merged Letters 

 

18. What is a macro? Write the steps to create and run a macro? 

Macros are a great way to automate your work in Microsoft Word. A macro is a set of 

tasks that can be performed by pressing a shortcut key, clicking a Quick Access toolbar button, or 

by selecting the macro from a list. Word supports a variety of options for creating your macro. 

Follow the below methods to create a macro in Word document - 

Method 1: Record a macro using the Button option 

Microsoft Word has the ability to record and run macros to improve the efficiency of the document. 

There are the following steps to record a macro in Microsoft Word - 

Step 1: Open the new or an existing Word document. 

Step 2: Click on the View tab on the Ribbon and click on the drop-down icon associated with 

the Macros in the Macros section. 

https://www.javatpoint.com/ms-word-tutorial


 
 

Step 3: Click on the Record Macro from the drop-down menu. 

Step 4: A Record Macro dialog box will appear on the screen in which do the following - 

1. Enter the Name for the macro in the Macro name text field. 

2. To use the same macro for the further document, click on the All Documents 

(Normal.dotm) option from the Store macro in drop-down menu. 

3. Click on the Button icon in the Assign macro to section to run your macro. 

 

Step 5: Now, click on the View tab and click on the Macros drop-down menu. Click on the Stop 

Recording Macro from the drop-down menu. 

Method 2: Record a macro using keyboard option 

Follow the below steps to record a macro using keyboard option - 

Step 1: Open the new or an existing Word document. 

Step 2: Go to the View tab -> Macros and select Record Macro from the drop-down menu. 

Step 3: A Record Macro dialog box will appear on the screen in which do the following - 

1. Enter the Name for the macro. 

2. To use the same macro for the further document, click on the All Documents 

(Normal.dotm) option from the Store macro drop-down menu. 

3. Click on the Keyboard icon in the Assign macro to section to run your macro. 



 
 

 

Step 4: A Customize Keyboard dialog box will appear on the screen. Press any combination of 

shortcut keys in the Press new shortcut key dialog box. Click on the Assign button. 

 

 

Step 6: Perform the action that you want to record. 

Step 7: Click on the View tab on the Ribbon and select on the Stop Recording from 

the Macros drop-down menu. 

Run a macro 

1. Go to View -> Macros and select View Macros from the drop-down menu. 

2. A Macros dialog box will appear on the screen. Select a Macro list that you want to run from 

the Macro name:. 

3. Click on the Run button, as shown in the screenshot below. 
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